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*  Rate Employees

*  Make, Review, Approve and Submit Recommendations
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Presenter
Presentation Notes
Today we will be reviewing general program information and the functionality of Workforce Compensation that you may need as a manager, along with tips for working with WC and tools and resources available to answer your questions during the compensation process.


Annual Focal Program
General Information

* Tools

— All managers will use the new Workforce Compensation (WC) tool to enter focal recommendations

* Timelines

— Each LOB may establish their own internal timeline for the process. Check with your manager on the
specifics for your organization

* Budgets

— Budgets are set at the top executive level for each organization. Each LOB head may determine the
method of allocating budgets to their organization

— WC Modeling feature is available to assist in pushing down budgets based on specific criteria
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Presentation Notes
Tools
This year, all managers will use the new Workforce Compensation tool to enter their focal recommendations.

Timelines
Your organization will have an internal timeline for the process to allow for review and approval before final submission.  Please check with your manager on the specifics for your organization.

Budgets
Budgets are published to the top executive level of the organization and each LOB leader is then able to determine the method of cascading budgets in their organization.
Workforce Compensation has a modeling feature similar to the budget wizard in CWB to assist managers in pushing down budgets, which we will review later in the presentation.


Annual Focal Program
General Information

* Eligibility
— Review the eligibility document posted on the Workforce Compensation website

— Be sure your employee population is reflected correctly on your WC worksheet
* Not all employees are eligible for the annual non-sales focal program

* Communication

— Do not communicate recommendations until you receive notification from Corporate
Compensation that approval has been obtained

— Always check WC before you communicate to ensure that the final recommendations
have not changed
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Presentation Notes
Please review this year’s process eligibility document, posted on the Workforce Compensation website.  The url is included at the end of this presentation in the Tools and Resources section.  Be sure your employee population is correctly reflected on your WC worksheet.  Remember that not all employees are eligible for the annual non-sales focal program.

Recommendations should not be communicated until approval has been received.  This notification will come from Corporate Compensation through your manager or HR manager.  Also, adjustments can sometimes happen during the approval process, so always check in WC  before communicating a recommendation.


Workforce
Compensation

Manager Planning

ORACLE
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Presenter
Presentation Notes
This next section introduces you to Workforce Compensation and explains how to access and use the tool as a manager.


What is Workforce Compensation?

* Workforce Compensation (WC) is an Oracle Self Service Application for
managing compensation processes, allowing you to:

— Allocate, model and distribute budgets to subordinate managers
— Rate employees

— Make, Review and Submit Recommendations for employees
— Review historical compensation information

—View and download employee information for offline work or further analysis

Note: Firefox is the preferred browser for WC
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Presentation Notes
Workforce Compensation is an Oracle Self-Service Application for managing compensation processes.  In the next several sections of our training, we will review the tasks that can be done in WC.

First, we will start with your budget.  The tool allows you to allocate, model, and distribute budgets to your organization.  This will include determining if you will pass budget down to subordinate managers, reviewing how to build a budget model, applying a model, and publishing a budget.

After we explain how to work with your budget in WC, we will give you instructions on how to download your worksheet to an Excel spreadsheet, in case you’d like to work offline.

Next, we will review how to Rate your employees

Finally, we will show you how to make recommendations, review your subordinate managers’ recommendations and, submit recommendations for your entire organization to your manager for approval.

You can also view historical compensation information and download employee information for further analysis.

When working with WC, remember that Firefox is the preferred browser.


Workforce Compensation

Login

1. From MyOracle Employee
Tools, click ‘Enterprise Apps’

—)

ORACLE
MY.ORACLE

ERMNAL COMMUMNICATIONS

You are here: MMarketing Home Internal '

EMPLOYEE TOOLS
Accessibility

Aria People Search

Asset Recovery & Recycling
Beeshive Central

Corporate Card

eSource

Global 1T Support

Hoowers

Identity Self Service [AFS)

3. Log on with your SSO credentials

Sign In

Username

first last@oracle com

Forgot password? Reset password via OIM or call the Oracle Helpdesk.

- - _

ORACLE

2. Select ‘Fusion Applications — Financials And HCM’

E-Business Suite Fusion Applications Fusion Applications
Self Service Applications (GSl) Financials And HCM CRM

MNavigator

Projects
FP Certification Letter...

4. In Navigator, select
Manager Resources >
Workforce Compensation

Workforce Maintenance
Data Exchange
Person Maintenance
Work Structures
Absence Administration

Compensation

Benefits

Plan Configuration

Manager Resources

— Workforce Compensation

My Information
My Portrait

NOTE: Your menu options may differ from ol Compensation Statements
what is shown here, depending on your Tools
Access level Downlod Orade

Download Orade ADF Desktop I...

Person Gallery

Spaces
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Presentation Notes
To access Workforce Compensation from the my.oracle.com homepage, select the “Enterprise Apps” link from the “Employee Tools” menu.

On the next screen, click the middle box titled ‘Fusion Applications – Financials And HCM’.

At the Sign In screen, enter your Single Sign-On credentials.

Once logged in, click on the Navigator icon, located in the upper right section, and select Workforce Compensation under the Manager Resources header.


Workforce Compensation
Landing Page — Tasks and Plans/Pools

* Tasks has sections for Compensate Workforce (1a) & Manage Budgets (1b)

— Below the headers are the Plan (2a) and Pool (2b) links which open their specific worksheets

* Compensate Workforce (3a) is the default display from the Navigator > Workforce Compensation link
— Click the Manage Budgets header (1b) to go to Budget Pools (3b)

— The Manager drop down (4) lets you view your subordinate managers worksheets

Workforce Compensation

Return to Compensation Work Area Manager John Smith EI @
| Tasks
Compensate Workforce
| C be Workfe
< 1a > ‘:mpensa © Tordores Primary Managed Plans
E3d Annual Bonus FYxx

E:Q Annual Equity FYxx - Plan Plan Access FaSrg Status Last Approval Action  Action History — Take Action

B Annual Focal Fyxx Manager Status % L)

More Annual Bonus FYxx o Updates allowed Mot started pt (=} EI
Manage Budgets Annual Eq uity FYxx #.Updates allowed Mot started T4t F‘@ EI
EZAnnual Bonus Budget FYxx Annual Focal FYxx & Updates allowed Mot started a8 3 =
E@Annual Equity Budget FYxx

More

Workforce Compensation

Return to Compensation Work Area Manager John Smith EI @
Tasks

Budget Pools Adjust Budget
C(impensate Workforce £ Detach
& Annual Bonus FYxx
— o i Overall Budget
E:Q Annual Equity FYxx Budget Pool Flan Access Level Eligible Workers Units

Annual Focal FYxx
More

Budget Amount
Annual Bonus Budget FYxx Annual Equity Grant Mo updates allowed 8 Shares

( 1 >r-| Budgets Annual Focal Budget FYxx Corporate Sales Focal Mo updates allowed 8 USD
lanage Budg

&G Annual Bonus Budget FYxx o
MF’@AnnuaI Focal Budget FYxx
jore
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Presentation Notes
The Workforce Compensation landing page has 2 sections: Tasks on the left and the Compensate Workforce Plans or Budget Pools to the right.

Tasks (1 & 2):
Items found under Tasks include  “Compensate Workforce” as indicated by (1a) and “Manage Budgets” as indicated by (1b). 
Clicking one of these topic headers will always return you to the Workforce Compensation landing page.
Links to specific plans are under the appropriate header, for example the “Annual Focal FYxx” as indicated by (2a) under the Compensate Workforce header and “Annual Focal Budget FYxx” as indicated by (2b) under the Manage Budgets header.

Plans/Pools (3):
The Plans or Pools sections, indicated by 3a and 3b, provides the user with a snapshot of information about the individual plan or pool.  This information includes the user’s access level or, in the Budget Pools section, the number of eligible workers and the overall budget.
The Compensate Workforce Plans page also includes “Take Action” short cuts which will “jump” you to the Worksheet page where you can take a specific action.
Both sections have links to their specific worksheet just like you see under Tasks. WC often provides several different ways to navigate to a page.

Manager drop down (4):
If you have direct reports who are managers, you will see them in the Manager drop down indicated by (4).  This allows you to view their worksheet and even “proxy” actions on their behalf.  If your directs have subordinate managers, use the Search feature and you can also see their worksheet.


Workforce
Compensation

Budget Allocation

ORACLE
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Now let’s begin with budget allocation.


Budget Allocation

* Go to Tasks > Manage Budgets and click

either link for the budget pool worksheet

* The initial time the budget is selected, you

must choose a budget method. Your

selection will affect the budget access settings

of subordinate managers

* Selecting the 2nd or 3rd option allows you to

adjust the budget access level settings of
subordinate managers if desired

Workforce Compensation

Return to Compensation Work Area
| Tasks

Compensate Workforce

E;i Annual Bonus FYxx
3 Annual Equity FYxx

Annual Focal Budget FYxx
More

E=l Annual Focal FYxx

Mare
Manage Budgets

Annual Bonus Budget FYxx

Man

29Er  John Smith EI

Budget Pools

i Detach

Budget Pool

Annual Bonus Budget FYxx
Annual Focal Budget FYxx

Select Budget Method

Budget Method (" I wil not pass down budgets to managers below me. Instead I wil hold the entire amount
" I wil pass down budgets only to those managers reporting directly to me
{7 1 wil pass down budgets to al of my lower managers

OK Cancel

~|/Manager Budgets 7|

Budget Method Direct reporting managers Edit

Manager

Actions = View = Format ~ | [ M Hfipetach | &l Wrap i3y Exp

Currency

=)

Budget Access Level

"Direct Reports

. - brown, Jack

usD

usD

&, Updates allowed
| EUDdEﬂZEE allowed

—

b= "Sagan, Katarina &% | No updates allowed El
« |
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Presentation Notes
To allocate a budget, click on the “Manage Budgets” header under “Tasks”.
Then click either the budget name under the “Manage Budgets” Header or under the “Budget Pool” to take you to the budget pool worksheet.  These 2 options are indicated by the red arrows.

The first time you go in to the “Manage Budgets” section you will be asked to choose a budget method.  This step is very important - it will determine the budget access of your subordinate managers.

The Budget Method options are:
1. I will not pass down budgets to managers below me.  Instead I will hold the entire amount
All your subordinate managers will be set to “No Access” for the budget worksheet.  Choose this options if you will make all the awards yourself.

2. I will pass down budgets only to those managers reporting directly to me (this is the most frequently used option)
Select this option to pass down budgets to your direct report managers.  Your direct report managers will have “Updates Allowed” access. You can adjust the settings for specific direct report managers within the budget worksheet.

3. I will pass down budgets to all of my lower managers
Select this option if you decide to pass down budgets to all subordinate managers.  All subordinate managers will have “Updates Allowed” access.  You can adjust the settings for specific subordinate managers within the budget worksheet.

Selecting the 2nd or 3rd option will allow you to adjust the budget access setting of subordinate managers if needed.


Budget Allocation

* Enter budget amounts in the New Budget: miivE i

Budget Method Direct reporting managers

Budget Distribution Amount column R e

Budget Access Level Exbe

Currency

Amount

— The Direct Reports row is the budget for o
recommendations to your direct reports _ﬁi‘z"- | —

4dit s alowed ]

* You must publish the Budgets so subordinate
managers can see their budgets publish Selected Badgets

— Click the drop-down arrow next to the Publish icon Publish All Budgets
& select an option

<~ Publish | -

— If publishing budgets to only a few managers,

highlight individual rows and use “Publish Selected
Budgets”

ORACLE
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Presentation Notes
The budget can be distributed to subordinate managers manually by entering amounts in “New Budget Distribution Amount” column as indicated by the red box.  
The “Direct Reports” row is the budget for you to give recommendations to your direct reports.

You must publish budgets for subordinate managers to see a budget on their worksheet.  To publish your budget, click the drop-down arrow next to the “Publish” icon and select an option.  You can choose to publish “Selected Budgets” or “All Budgets”.


Workforce
Compensation

Budget Modeling

ORACLE


Presenter
Presentation Notes
In order to distribute your budget, you may need to do some modeling first.


Budget Modeling

* Models make it easy to see how different allocation methods and criteria
affect your budget

* Who might create Models —

— Managers who intend to pass down budgets to subordinate managers
— Managers who intend to make the allocations themselves (hold the entire budget)
— Different models can be created, previewed and applied before publishing the budget

NOTES:

- Applying a model will overwrite any previously entered recommendation amounts
- Models should never be applied after the budget has been published

ORACLE
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Presentation Notes
Models make it easy to see how different allocation methods and criteria affect your budget distribution.

Different models can be created, previewed and applied. Your modeling should be completed before you publish a budget.

Remember, applying a model will overwrite any previously entered recommendation amounts.  More importantly, models should never be applied after the budget has been published.


Create a Budget Model

Create Model

* On the Manager Budgets worksheet, click the drop-down arrow next to the
Model icon and select ‘Create Model’

Manager Budgets

Budaget Method Direct reporting managers Edit

Actions ~ Wiew = Format [P | |EL[[JFres=et] '

Manager

Wrap = view as List & Model | - =TfPublish | -
Create Model
Open Model
Apply Model

* Enter the Model information and click Continue

Create Model

* Model Name |

Flan Annual Focal
Assocdated Budget Annual Focal Budget FYxx

Continue

Cancel

b4
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Presentation Notes
To create a budget model, click the “Model” icon drop-down on the budget worksheet, select “Create Model”.

Enter a model name – choose one that is meaningful to you.

The plan name and other info will default to values determined by the plan administrator.
Click “Continue”.


Create a Budget Model

Model Properties

1. Choose an Allocation Method from the drop-down list

2. Select up to four Criteria from the drop-downs

Note: Criteria 3 and 4 will not appear until the first two are entered

3. Click ‘Build Model’

Create Compensation Model: ... Currency USD - US Dollar [~ | Manage All Models Save |~ | Save and Close

Model Properties

* Mame My Budget Model Creator John Smith

: A iated Pl Annual Focal FYxx
' * Allocation  pllocate n amount per person EI @ sEoes =
Method Component FYxx Annual Focal

Model Access  Limit model access to model creator EI
Criteria
* Criteria 1 Job [+| criteria 2 Country [=]

Criteria 3 Career Level EI Criteria 4

Build Model @
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Presentation Notes
Under the model properties section choose an allocation method from the drop-down list indicated by (1).

Under the criteria section enter up to 4 criteria for the model.  Use the drop-down lists to made your choices.  The criteria 1 and 2 fields are automatically displayed.  The criteria 3 field will appear after a criteria 2 is entered and the criteria 4 field will appear after the criteria 3 field is entered.

When finished, click “Build Model”.


Create a Budget Model

Model Details

* Enter amounts in the Model Values section to calculate and reduce the

Available Budget accordingly
— Click the arrows to expand or collapse the levels

— Use the inner scroll bar to view the entire list

Model Details

Totals for This Model Budget =
Workers Induded Total Amout Owerall Budget Available Budget
52119 of 62119 / 330,000, 30,000,000.00 29,670,000.00
view v~ Format~ [  Efipetach  {ZH Export
Model Values
Job { Country [ Career Level Total Workers Amount for Each
Worker Total Amount
1000 10.Hardware Sales Representative I.SALES.SPECPROD.IC1 12 -
Braxzil 1 |
= IC1 1 30,000.00 30,000.00 =
> Japan 3
» Saudi Arabia 2
United States -
. . . > IC1 & 50,000.00 300,000,00
Cl ICk PrEVIEW » 100020.Hardware Sales Representative I1.SALES. SPECPROD.IC2 41
) > 100030.Hardware Sales Representative III.SALES. SPECPROD.IC3 191
M OdEI Res u ItS = 100040.Hardware Sales Representative IV.SALES. SPECPROD.ICS 661
= 100050.Hardware Sales Representative V. SALES. SPECPROD.ICS 178
= 100130.PC Board Designer 3.PRODEV.EMNGSVCS.IC3 1 -
Preview Model Results -
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Presentation Notes
The model details will then appear below the criteria.  You can now enter amounts in the “Model Values” column.

Once your model is done, click the “Preview Model Results” button.


Create a Budget Model

Preview Model Results

* The Summary displays the number of employees & budget data

* Two other tabs:
— Worker Detail (the default view)
—Manager Rollup (shows budget by subordinate manager)

Preview Model Results: Currency | USD - US Dollar [=] Return to Model || Apply Results | - Done
Summary
Totals for This Model Budget
Workers Induded Total Amount Owerall Budget Available Budget
52119 0f 62119 330,000 30,000,000 29,670,000

Waorker Detail Manager Rollup

View - g i Detach Show  All workers [=]
. Model Results
Mame Manager Mame Hierarchy Lewvel Job
Amount

-.-!\Ii, Mohamed Ahmed Mohamed Farouk, Tamer 5 3327.5ales Snr Manager. SALES.S. .. -
| -MANU, Christiana Sakho, Annick =] 3303.Technology Sales Represent... i

"a Jamal, Firoze Shivaprasad, Lata =] 42004, Course/Curriculum Dew 4T ... =

-A, Ellawarasan Polamreddy, Murahari Reddy 7 90121, Technical Analyst 2-Suppor ...

", Mahesh Kumar Varma, Bibhu a 20310, 5taff Consultant, CONS.IM...

-.-!\, Meena Maagabeina, Venkat Ramana 7 10710, Applications Developer 1.P...

-.-!\, Mina Robson, Mark <] 90023, Technical Analyst 4-Suppor ...
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Presentation Notes
On the “Preview Model Results” screen:
The number of employees and budget information is shown in the Summary section.
There are 2 tabs on this screen – worker detail which is the default and manager rollup which shows the budget by subordinate manager.


Create a Budget Model

* Click Done to return to the Workforce Compensation landing page

Preview Model Results:

Currency  USD - US Dollar EI Return to Model Apply Results vI Done

* Optional:

Click Return to Model to return to the model properties.

— If you have NOT published the budget yet, you can apply the results of your model

NOTE: Applying a Model will overwrite any previously entered awards
* Click the arrow next to the Apply Results button
* Choose Apply to Budget Amounts from the drop-down list
* Go to the Budget worksheet and confirm the model amounts have been applied

Preview Model Results:

Currency  USD - US Dollar El Return to Model I Apply Results | - I Done

Models should never be applied after the budget has been published

ORACLE
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Click “Done” to return to the Workforce Compensation landing page or “Return to Model” to go back to the model properties to adjust the model.

If you have not published the budget yet, you can apply the results of the model.  Click the “Apply Results” button and choose “Apply to Budget Amounts” from the drop-down list

Go to the budget worksheet and confirm the model amounts have been applied.


Workforce
Compensation

Excel Export

ORACLE

Copyright © 2015, Oracle and/or its affiliates. All rights reserved. | Oracle Confidential — Internal

19


Presenter
Presentation Notes
Next, we will give you instructions on how to export your worksheet to Excel if you choose to work offline.


Excel Export

A Worksheet

Actions = \View v~ Format - E Freeze %Debd‘: <}—_r| Wrap 'EE View as Tree j Visible Rows 125

Mame = | Eligibility Status - Country | |=| Job =| |=| Team Direct Reports ~| || & 3% Clearal

Employes Mame Country Fegion Us and Intermational Job Career Lewvel Eligibility Status Ineligible Reason Job Function Code Spedalist Area

* Manage in Spreadsheet (Export/Import feature) is a two-way process for spreadsheet
download and upload, which requires:

— Download and installation of ADF Desktop Integration
— Configuration of Excel

* For detailed instructions, please refer to the “WC ADFdi Installation Instructions.docx’

posted on the Workforce Compensation website:
http://my.oracle.com/site/hr/global compensation/fwc/

)

NOTE: You must download and install the latest version of ADF Desktop Integration, which became
available on May 4, 2015. Please uninstall any old versions and install the new version.

ORACLE
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Presentation Notes
You may complete planning for your employees in the tool, or you can choose to export your worksheet to Excel and plan offline.
The Manage in Spreadsheet function is a two-way process that allows you to export to Excel, make recommendations and import back into WC, if you choose.

To use this feature, you must download and install the latest version of ADF Desktop Integration and configure Excel.  If you have a version prior to May 4, 2015, you must uninstall the old version before installing the new version.  For detailed instructions on how to download and install ADFdi, please reference the Word file posted on the Workforce Compensation website.

http://my.oracle.com/site/hr/global_compensation/fwc/

Workforce
Compensation

Rate Employees
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The next section will show you how to enter ratings.


Rate Employees

Workforce Compensation

* From the WC landing page, click ey o8
either link to open the worksheet “/\w‘“ T — e e g e
Hors nnual Bonus FYxx Zupdatesalowed ot started 3 ) [~
for the Compensate Workforce plan |52

A
Annual Equity FYxx Zupdstes alowsd Mot started & =} [+
Annual Focal FYxx Zupdatesalowed  Not started g ) [+

* On the Compensate Workforce -
. Actions v View v Format~ ¢33 || |[[JFreeee”| ffipetach | oJwrap g ViewasTree [
WOFkSheet, SCFO” Untl| yOU see the Name | Eligbility Status = | =] work Country

. C fi
Ratl n g CO I u m n E-Mail Employee Name Wark Country Career Level P::?:upfgs:c:r;‘.aﬁng ‘
- Current
o - Compensation Compensation
Use the drop-down to select the ==
: : - Current - Prior
appropriate rating = =
*Note: The actual location of the Performance Rating 1 - Unsatisfactory
. 2 = Inconsistent
c_olumn may vary, angl you can cu§tom|ze your worksheet e
view by moving, adding or removing columns. 4 - Exceeds Expectations
5 - Qutstanding
ORACI_EW Copyright © 2015, Oracle and/or its affiliates. All rights reserved. | Oracle Confidential — Internal/Restricted/Highly Restricted 22



Presenter
Presentation Notes
To rate your employees, from the Workforce Compensation landing page, click the plan name either under “Compensate Workforce” or under “Primary Managed Plans”.

On the worksheet, scroll over until you see the Rating column.
Use the drop-down to select the appropriate rating.
Always Save any entry you make.

The requirements for entering ratings is determined by Line of Business.  Check with your manager if you are unsure of the process for your organization.


Workforce
Compensation

Make Recommendations

ORACLE
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Presentation Notes
This section shows you how to make recommendations for employees.


Make Recommendation
View your Budget: Option 1 — Worksheet View

* If you do not see your Budget information on your Compensate Workforce
worksheet ), check the Team filter @

~ Summary: Direct Reports (D
Componene (Qurencyor | e workers wan| "NGE oyt sy Compenmstion| compensstion| VTSNS ouoelis)  sudgetby| vt udget
Annual Focal usD 10 0 0  260.000.00 0.00 0.00 26.000.00 26.000.00
« it
~ Worksheet [2]
Actions = View » Format - &= ] Freeze [ Detach <J wrap B2 View as Tree @F Export | & Model | v@'xsible Rows 125
Name | =| Country | | =] 30ob | =] ITeam Direct Reports x| | =] IAclvanced x| (] & ®CearAl

* Select ‘All’ from the drop-down and click the arrow to the right of Team (),
your budget amounts should now display®

e

~ Summary: All Workers U4
| 1 | Owveral |
| CLImency Elgible, Workers W'l.h Bl !wag! d; § Satary| Compensation Cmnpertgl:lm' B‘% s Budget w Avalable Budget
T e ] o] Compenetion) compensated| | Amount]  Percenf3ge| organizaton| Organcatio] Te3MFPRer| by Team Flter
= Annual Focal usoD 10 0 0 260000 00 0.100 0.00 26.000.00 26.000.0 2600000 26.000.00
= Worksheet 7]
ACtions = View = Format = =] Freeze [l Detach ol wWrap T view as Tree | @#% Export & Moded v®m= Rows: 12 §
Name | Country =| [=] 3ot =] [=] [Team A =| ||| Advanced = =] H#* & Cearal
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There are two ways to view your budget.  The first option is in your Compensate Workforce Worksheet View.

If the Team filter shows “Direct Reports” as indicated by (2), you will not see your budget as indicated by the red box 1.  Select “All” from the drop-down and click the arrow to the right of Team as indicated by (3).  After clicking the arrow, your budget amounts should now display.


Make Recommendation
View your Budget: Option 2 — Approvals Tab

* Another way to view your budget is from the Approvals tab. Click the
Compensation Overview link and scroll to the right to see the budget
information.

Focal A pprowvals
Approvals il Compensation Overview B Alocation Statistics | Sabry Range Analysis | Alerts

Component | Salary [=]

View ~ Format - [ Detach

Ebgible Compensation
Salary Amount

w "Doe, John Q 3,000,000 3,000,000

Direct reports
"Brown, Betty
"Brown, Jack
®Sagan, Katarina
“Brown, Betty

2,500,000 |

0 0Q00
N

VYVVYV
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Another way to view your budget is from the approvals tab.

Click the “Compensation Overview” tab and scroll to the right to view your budget information.

This is the recommended option.


Make Recommendation
Entering Recommendations: Option 1 - Directly into WC

* Enter job changes into the Proposed Job and Proposed Discretionary Title
columns

* Enter salary changes into the Salary Increase Amount (LC) or Percentage of
Eligible Salary columns. The other column will auto-calculate

* After making entries, save your work

Worksheet

Actions = WView = Format~ 23 [EH  |H[Freeze | &l Detach oJl wrap T view as Tree [F & Model | = visible Rows 155
[
Mame = | Eligibility Status - | Work Country - +| Job -
Waork Career ) . Eligible Salaryl] Salary Increase  Percentage of | Percentage of
oYy Country Lewvel -t FiliizEroii SETE L LC) Amount (LC) Eligible Salary Base Salary
'Brown, Betty |US ICS 50550.HR. Consultant 5.HR.GEMHR.IC - 5r. M&A Consultant, Compensation 43,657.53 0.00

WARNING!

. DO NOT SUBMIT until ALL your subordinate managers have submitted
Q_E . their work to you. Your submittal removes their Update access.
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Please review the employees on your spreadsheet.  If you are missing an employee, or if there is inaccurate information, please contact your HR Manager.

You also have two methods to enter recommendations for employees.  The first option is to enter recommendations directly into the WC tool. You will make a recommendation for either a salary increase AMOUNT in local currency, or a percent of the eligible salary, and you could also propose a job change and/or discretionary title change on this screen as well.

After making entries, please remember to save your work.

Please do not submit your recommendations until all your subordinate managers have completed their recommendations.  Submitting will make it so all managers below you won’t be able to make any changes to their recommendations.


Make Recommendation

Entering Recommendations: Option 2a — Excel Export to Work Offline

* Click the Manage in Spreadsheet icon

Worksheet
Actions ~ View > Format~ ¢ H Freeze jf{ Detach il wrap TR View as Tree

Visible Rows 122
| Eigbility Status =) || Country = |=] Job =] || Team DirectReports

Employee Name Country Region US and International Job Career Level Eligibility Status I

* Click “Yes” on the Connect pop-up. You will need to log in using your SSO credentials

* If your downloaded file has no data, then your download was unsuccessful

* A successfully downloaded file will have ‘Download Again’ and ‘Upload’ buttons that are activated and

employees listed starting on row 7

* Verify the Proposed Job, Proposed Discretionary Title and Salary Increase Amount (LC) columns have no
background color and recommendations can be entered

I B C D E F G H I J K L M M O B Q
1
2 ’ Download Again “ Upload ]
3
4
5
Proposed Eligible |Salary Percentage Percentage
Elgibility Work Career Proposed Discretionary Discretionary Salary Increase of Eligible of Base '
6 Changed Status | Fagged |Employee Name Status Country |Level Job Job Title Title {LC) Amount (LC) |Salary Salary
[ & Brown, Betty Eligible us 60350.HR Sr. MEA 49,657.33 0.00

ORACLE
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The second option is to export to an Excel spreadsheet, plan offline, and import recommendations back into the Workforce Compensation tool.

To do this, click the Excel “Manage in Spreadsheet” icon to start the export process.
Click “Yes” on the Connect pop-up.  Then log in using your SSO credentials.
If your downloaded file is an empty template with no data, then your download was unsuccessful.
A successful download will have employee data starting on row 7 and active “Download Again” and “Upload” buttons.
Verify the “Proposed Job”, “Proposed Discretionary Title” and “Salary Increase Amount (LC)” columns have no background color and recommendations can be entered.


Make Recommendation
Entering Recommendations: Option 2b — Excel Upload to WC

NOTE: If you are working remotely, you must connect via VPN to upload your file

* In Excel: P e—— =
— Click the Upload button and click OK to select the default Upload Options T e
— The upload will process S
— Upload is complete when you see the Invoke Action pop-up that says ————

“Worksheet was uploaded”

Invoke Action

— Click OK and scroll to column D to verify the rows updated successfully

/\x Worksheetwas uploaded.
@ In WC: % c | D E
— Click the plan link to refresh the Worksheet and verify your changes were
uploaded

Cha Status Flagged

et

Row updated successfully

ORACLE
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Once manager recommendations are complete offline in Excel, you will need to upload your recommendations back into WC.

In Excel:
Click the “Upload” button and click “OK” for the default ‘Upload Options’.
The upload will process and when it is finished you will see the “Invoke Action” pop-up that says “Worksheet was uploaded”.
Click “OK” and scroll to column D in the spreadsheet to verify the rows updated successfully.

In WC, click the plan link to refresh the worksheet and verify your changes were uploaded.


Workforce
Compensation

Review, Approve and Submit

ORACLE
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In this section, we will cover how to review, approve and submit your recommendations.


Review, Approve and Submit
Review: Return for Correction or Request Information

If subordinate managers need to make corrections or you need more information before approving,
highlight the manager’s row and click Return for Correction or Request Information, respectively

Focal

Approvals

Approvals | Compensation Overview | Allocation Statistics | Alerts

Actions = View = Format - &4 Detach & Approve | vI [ Return for Correction  [Z] Request Information I 2
Status Approvals
Manager Access Level Manager's Worksheet Ma_lr_13gers Approval Action |Due Date
Status caM - gratus History
Status
7 " Doe. John &, Updates allowed Budget available [+37) [}
&= "Brown, Betty &, Updates allowed Processe d & B 20

Return for Correction

Request Information

Enter a Comment explaining the issue the
manager must correct

Details

To

Comments

Return for Correction

Return worksheets to selected managers and automatically notify them that
access is restored to make corrections.

L

Enter a Comment asking for the needed detail

Request Information

To

Comments

ORACLE
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If your subordinate managers need to make corrections after they submitted their recommendations or if you need more information before approving, you may make those requests within the tool.

Click either “Return for Correction” or “Request Information” and type in your comments in the pop-up box.


Review, Approve and Submit

Review: Worksheet Status

* On the Approvals tab, you can see your Approval Status and the Status of

your subordinate managers:

* Click the Team Status or Action History icons for more information

ORACLE

Focal Approvals
Approvals | Compensation Overview | Alocation Statistics | Salbary Range Analysis | Alerts
Actions = View ~ Format = | Detach @ approve |~ [ Return for Correction  [3] Request Information @
i _ Status I Approvals |
Manager = Manager's s | oue
| 220l wWorksheet Team !ﬁpprovd Status | Action History l e
W "Doe, John &, Updates allowed Work in progress & (3 Returned for Correction by Betta Duxmire [} 7-Mar-2014
- "Brown, Betty &, Updates alowed WWork in progress i 8 Returned for Correction by John Doe [ 7-Mar-2014
B o "Brown, Jack &, No updates alowed Processed & [ Approved by John Doe @ 7-Mar-2014
b "Sagan, Katarina & Updates alowed Not started & (1} 7-Mar-2014
b= "Suki, Lee & Updates alowed Work in progress B 8 Returned for Correction by John Doe & 7-Mar-2014
Action History L]
Approval Chain
Betta Duxmire * Joanne Olsen * Mark Hurd * Lawrence Ellison
Action History
@ Work in progress Doe, John 22-Mar-2014 03,05 PM
28 Submitted Doe, John 22-Mar-2014 03.06 PM
3 Returned for correction  Duxmire, Betta 22-Mar-2014 03.22 PM
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You can review the status of your subordinate managers from the Approvals tab.


Review, Approve and Submit
Approve

* Approve your subordinate managers’ submissions via the Approvals tab.
Click the drop-down arrow to the right of Approve and make a selection:

— Selected Managers: First select a single manager or use the Ctrl key @7 I~

Selected Managers

to select multiple managers. Then choose ‘Selected Managers’ from Al Managers
the Approve drop-down.

— All Managers: Approves your entire hierarchy.

* Verify your subordinate managers’ Approval Status shows

o ) Focal Approvals
pprcve y <your nal I |e> Approvals | Compensation Overview | Alocation Statistics | Salary Range Analysis | Alerts
Actions » View » Format » | [ff Detach (3] Request Information | (%]
: _Status. | Approvals |
|Manager’s Manager’s | |
s e Worksheet Team |Approval Status Action History DRS DR
Bl | | Status | Status_ ] |
V "Doe, John &, Updates alowed  Work in progress @3 @& 7-Mar-2014
t> "Brown, Betty &£, No updates alowed  Processed 4 [@Approved by John D o Q 7-Mar-2014
B o “Brown Jack & No updates alowed  Processed @ [ Approved by John Doe Q 7-Mar-2014
b= "Sagan, Katarina & Mo updates alowed  Processed @ @ Approved by John Doe ) 7-Mar-2014
B " Suki, Lee & No updates alowed  Processed bt [ Approved by John Doe a 7-Mar-2014

ORACLE
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Use the Approvals tab to approve your subordinate managers’ submissions, either individually or all at once by clicking the drop-down arrow to the right of “Approve” and selecting either “Selected Managers” or “All Managers”.

To approve selected managers, select a manager or use the Ctrl key to select multiple managers, then choose “Selected Managers”.
Choosing “All Managers” will approve your entire hierarchy.

After approving, you can verify your approval in the Approval Status column.


Review, Approve and Submit
Submit: Warning

DO NOT submit until your subordinate managers
have completed their submission to you

When you submit, you are submitting your entire organization

If you submit before everyone has completed their work,
you must manually change the update status for every affected manager

ORACLE
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Submit only when your entire organization has completed their recommendations.  When you submit you are submitting your entire organization.  If you submit before everyone has completed their work, you must manually change the update status for every affected manager.  There is no way to do this automatically.


Review, Approve and Submit
Submit: Option 1 — Compensate Workforce Worksheet

* On the Compensate Workforce Worksheet, click the Submit button in the
upper right corner

Compensate Workforce: Annual Bonus ... Currency USD - US Dollar El Save | Submit | Cancel

Focal Approvals

NOTE: When you Submit, you are submitting your entire organization.

ORACLE
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There are two ways to submit your recommendations to your manager for approval:
The first option is on the Compensate Workforce Worksheet, click the “Submit” button in the upper right corner.


Review, Approve and Submit
Submit: Option 2 — Compensate Workforce Landing Page

* On the Compensation Workforce > Primary Managed Plans page, click the
Take Action drop-down and select Submit for approval

Compensate Workforce

Primary Managed Plans

Plan Plan Access

Annual Bonus FYxx & Updates allowed
Annual Eq uity FYxx & Updates allowed
Annual Focal FYxx | Updates allowed
Annual Sales Focal FYxx # Updates allowed

Status

- team @StApproval Act Action History Take Acti

Mot started b3t & =
Mot started % @ N

Work in progress & & e rTeDOf'T

Mot started &5 & 3

At this point you are finished with the process

Do not communicate recommendations until you receive notification
from Corporate Compensation that approval has been obtained

Always verify in WC before you communicate to employees
to ensure that the final recommendations have not changed

ORACLE
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The second way to submit for approval is on the Compensate Workforce -> Primary Managed Plans page, where you can click on the Take Action drop-down and select “Submit for Approval”.

You have now finished the recommendation process.
Please remember not to communicate any recommendations until you receive notification from Corporate Compensation through your manager or HR manager.
Also adjustments can sometimes happen during the approval process, so always check in WC  before communicating a recommendation.


Workforce
Compensation

Tips and Resources

ORACLE
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Presentation Notes
In this last section, we will share some helpful tips when using the Workforce Compensation tool and resources to help answer your questions.


WC Tips

Browsers

* Firefox is the preferred browser

* Use the latest version of Mozilla Firefox

@ 17K Home - Moxzilla Firefox

— Check your version: file Edit View History Bookmarks Tools [Help)
Firefox Help
FrOm the Menu Bar} . | Firefox Health Report
select Help > About Firefox | Lroubleshooting fnfomation
Submit Feedback...
. ? Restart with Add-ons Disabled...
— Download the latest browser version at MyDesktop Remort Web Forgeny .

About Firefox
e Other Browsers ﬂ .

Firefox ESR
.
Firefox is designs Mazilla, a global commanity working
apen, blic a cessible to all.
it Privacy Policy

— Internet Explorer

ORACLE
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As mentioned earlier, Firefox is the preferred browser.  Be sure to use the latest version of Firefox, which can determined by following the instructions on this slide.  If needed, download the latest browser from “MyDesktop.”

You may also use Chrome or IE as well.


WC Tips

Collapsible Panes and Expand Arrows

To see more fields without scrolling or if the Team filter is not visible:

1. To gain more work space, click on the left-pointing arrow to collapse the Tasks pane.

2. To show hidden filters, click on the double right-pointing arrows to expand the
Worksheet options

Tasks
Compensate Workforce: Annual Focal Currency Worker local currency | | Done

Compensate Workforce

E Annual Bonus FYxx
[ Annual Equity FYxx

Worksheet
3 AAnnual Focal FYxx Actions * View v Format v 2§ = G i Detach ol Wrap T View as Tree F b2 ?@
Manage Budgets ;o

Annual Bonus Budget FYxx
Annual Equity Budget FYxx Employee Mame E-Mail Work Country Career Level Crade Start Date Eligible Salary
Annual Focal Budget FYxx |_|

ORACLE

Focal Approvals
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As you use the tool, you may find you need more space on your screen.  You can achieve this by collapsing the “Tasks” pane by clicking the left pointing arrow – indicated by the red circle with the number 1 on this slide.
If your screen is small, you may also find that certain Worksheet filters are not visible, such as the “Team” filter.  You can expand the hidden filters by clicking on the double point right arrows – indicated by the red circle with the number 2 as shown here.



WC Tips
Nested Scroll Bars

Edit Compensation Model: TestModel

* WC has nested scroll bars (inner and outer) . T

~IModel Properties =

— You may need to use the vertical scroll bar to i g Sk

P&

reveal the horizontal scroll bar at the bottom g e e Jﬂ B

* Here, the horizontal scroll bar was out of sight Crtea 3 Compensation Prcrmance ot - i | Crers

Rebuid Model |

— By using the vertical scroll bar, e | |
the horizontal scroll bar was revealed Metsink . Tewmew  gumtedoe s

View ~ Format~ ¢ B i Detach

| Model Values

Total Workers | amount for Each
Worker

Country / Career Level / Compensation

Performance Rating - Prior Total Amount

W Argentina
- M3

WV Australa
- IC4

B M3
o~ Brazi
& Canada
b= France
- Germany
[ Hong Kong
- Hungary
- Inda
&= Ireland

~
Preview Model Results =
< | _'l_l

g -
= W N = =N =R = e
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Workforce Compensation uses nested scroll bars.  You may need to use the vertical scroll bar to reveal the horizontal scroll bar at the bottom of the page.  The example on this slide shows that the horizontal scroll bar was out of sight and by using the vertical scroll bar, it was revealed.


WC Resources
Contacts & WC Website

* Questions about:
— Timeline and Budget for your organization: Contact your manager or HR Manager
— Eligibility: Contact your HR Manager

— Workforce Compensation access and functionality: Submit MyHelp ticket at:
https://myhelp.oracle.com/app/answers/answer view GA/a id/323/loc/en US/g id
/356# highlight

* For more detailed information, please refer to the Workforce
Compensation website:
http://my.oracle.com/site/hr/global compensation/fwc/

ORACLE
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Questions about your organization timeline and budgets for this process should be directed to your manager and/or HR Manager.

Questions about eligibility, after you have reviewed the eligibility rules, can be directed to your HR Manager or the Compensation mailbox at fusion-comp_ww@oracle.com

Submit questions on WC access and functionality to MyHelp - Compensation at the url listed.

These training slides, along with a managers guide and eligibility document will be available on the Workforce Compensation website at the url shown on this slide.

https://myhelp.oracle.com/app/answers/answer_view_GA/a_id/323/loc/en_US/g_id/356
http://my.oracle.com/site/hr/global_compensation/fwc/

Questions

ORACLE

Copyright © 2015, Oracle and/or its affiliates. All rights reserved. | Oracle Confidential — Internal

41


Presenter
Presentation Notes
This concludes our training on how to use Workforce Compensation to make your annual focal recommendations.
Your HR or compensation representative is now available to answer any questions.


ORACLE
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